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1. Implementarea VHDL a unei FSM

In aceasta parte se propune studiul cu ajutorul instrumentelor FPGA Advantage a unei masini
cu stari finite (FSM), a carei diagrama se prezinta in figura 1. In figura 2 sunt ilustrate formele de unda
care stimuleazd FSM. Apoi se prezinti implementarea VHDL a acesteia precum si o structura de test

(test bench), pe baza formelor de unda.

N

Studiati cu atentie modul de implementare a FSM in  arhitectura

FSM_CAR_SPEED_CNTL_2, prin cele doua procese: FSM2_COMB si FSM2_SEQ)!

Observati modul de realizare a test bench-ului, avand in vedere formele de unda din

figura 2 si remarcati prezenta procesului pentru atribuirea secventiala de valori!

1. Precizati care front al clock-ului este activ in sistem si argumentati! Nu uitati de
timpul de simulare si ganditi-va cd in interiorul unui proces atribuirea de valori unui semnal este
interpretata ca un latch dacd nu este clock sau ca un bistabil (cazul de fatd), daci procesul

include un clock!

2. Gasiti o solutie pentru a determina semnalul Speed sa se modifice odata cu Speed_s!
3. Ce pidrere aveti despre sincronicitatea (fatd de clock) a evenimentelor din procesul

FSM2_COMB?
4. Precizati succesiunea de stari a FSM pentru formele de unda din figura 2!
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--Car _FSM vhd

- - CAR _pack
library | EEE;
use | EEE. STD_Logi c_1164.all, |EEE. Nuneric_STD. al | ;

package Enum St ate_Encode_Types is
attribute Enum State_Type_Encodi ng :string;
type STATE TYPE is
(Stop, Slow, Medium Fast);
attribute Enum State_Type_Encodi ng of STATE TYPE: type is
("11 10 01 o00");
end;

--Car _FSM

library | EEE;

use | EEE. STD Logi c_1164.all, |EEE. Nuneric_STD. all;
use wor k. Enum St at e_Encode_Types. al | ;

entity FSM CAR SPEED CNTL_2 is
port (d ock, Keys, Brake, Accelerate: in std_|ogic;
Speed: out STATE_TYPE);
end; -- entity FSM CAR _SPEED CNTL_2;

architecture RTL of FSM CAR SPEED CNTL 2 is
si gnal Next Speed : STATE_TYPE;
si gnal Speed_s : STATE_TYPE;

begin

FSM2_COMB: process(Keys, Brake, Accelerate, Speed_s, Next Speed)
begin
-- "Speed_s" este un semmal intern care porteaza semmal ul "Speed",
--astfel incat "Speed" sa ramana de tip "out"
case Speed_s is
when Stop =>
if (Accelerate='"1") then
Next Speed <= Sl ow,
el se
Next Speed <= St op;
end if;
when Sl ow =>
if (Brake='1") then
Next Speed <= St op;
el sif (Accelerate="1") then
Next Speed <= Medi um
el se
Next Speed <= Sl ow,
end if;
when Medi um =>
if (Brake="1"') then
Next Speed <= Sl ow,
elsif (Accelerate="1") then
Next Speed <= Fast;
el se
Next Speed <= Medi um
end if;
when Fast =>
if (Brake="1") then
Next Speed <= Medi um
el se
Next Speed <= Fast;
end if;
when ot hers =>
Next Speed <= St op;
end case;
end process FSM2_COWVB;
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FSM2_SEQ process (C ock, Keys)
begin
if (Keys='"0") then
Speed_s <= Stop;
elsif falling_edge(d ock) then
Speed_s <= Next Speed;
end if;
Speed <= Speed_s;
end process FSM2_SEQ

end; -- architecture RTL;

-- Modul ul generator de clock:

library | EEE;
use | EEE. STD Logic_1164.all, |EEE. Nuneric_STD. all;

entity Cock_Gen is
port (C ock: out std_logic);
end O ock_Gen;

architecture SPEC of Clock_Gen is
constant clk_prd: time := 200 ns;
si gnal int_clk: std_logic :="'0";

begin
int_clk <= not int_clk after clk_prd/?2;
Clock <= int_clk;

end SPEC;

-- Generarea semal el or de test pentru CAR _SPEED CONTROLER

library | EEE;
use | EEE. STD Logic_1164.all, |EEE. Nuneric_STD. all;
use wor k. Enum St at e_Encode_Types. al | ;

entity FSM CAR Control is
port (Speed: in STATE_TYPE;
Cl ock, Keys, Brake, Accelerate: out std_|logic);
end FSM _CAR Control;

architecture DRV of FSM CAR Control is

constant clk_prd: time := 200 ns;

signal Cock_in, Keys_in, Brake_in, Accelerate_in: std_|logic;

si gnal Count Stop, Count Sl ow, Count Medi um Count Fast: STATE TYPE := Stop;
component Cl ock_Gen

port (O ock: out std_logic);
end conponent;

begin
Sursa: O ock_Gen
port map (d ock => O ock_in);
process
begin
Keys in <= '0"' after clk_prd/2,'1" after 2*clk_prd, '0" after 14*clk_prd;
Brake_in <= '0" after clk_prd/2, '1' after 4*clk_prd, '0" after 6*clk_prd,
"1'" after 1l*clk_prd, '0" after 14*clk_prd;
Accel erate_in <= '0" after clk_prd/2, '1' after clk_prd, '0" after
5*clk_prd, '1' after 7*clk_prd, '0' after 10*cl k_prd;
wait for 15*cl k_prd;
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end process;

Accel erate <= Accel erate_in;
Brake <= Brake_in;

Keys <= Keys_in;

Clock <= dock_in;

end DRV;

-- CAR TEST BENCH:
-- Este autoconsistent si contine nodulul CAR_SPEED CONTROLER
-- si nmodul ul ce genereaza semal el e de test pentru acesta.

library | EEE;
use | EEE. STD Logic_1164.all, |EEE. Nuneric_STD. all;
use wor k. Enum St at e_Encode_Types. al | ;

entity Car_Test_Bench is
end Car_Test _Bench;

architecture STRUCT of Car_Test_Bench is
signal O ock: STD Logic;
signal Keys, Brake, Accelerate: STD Logic;
signal Speed : STATE_TYPE;

conmponent FSM CAR_SPEED CNTL_2
port (Cl ock, Keys, Brake, Accelerate: in std_|logic;
Speed: out STATE_TYPE);
end conponent;

conponent FSM CAR Contr ol
port (Speed: in STATE TYPE;
Cl ock, Keys, Brake, Accelerate: out std_logic);
end conponent;

begin
Car: FSM CAR_SPEED CNTL_2
port map (d ock => d ock,
Keys => Keys,
Brake => Brake,
Accel erate => Accel erate,
Speed => Speed);
Driver: FSM CAR Control
port map (Speed => Speed,
Cl ock => d ock,
Keys => Keys,
Br ake => Brake,
Accel erate => Accel erate);
end STRUCT;
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2. Pornirea FPGA Advantage si deschiderea unui proiect

Se acceseaza programul pe calea Start > Programs > FPGA Advantage > FPGAdv Pro i pe
ecran va apare fereastra principald “HDL Design Browser”, care arati precum in figura 3.

Fi= Edt Wisw HDL Gnimstion Took Flows Opbors Window Help

W-FE e F(ERBEE RS aE B[ L
t S S5l B
L= O SCRATEN LB - D Progane P PRAc s esanpiesbs_s | BLLLE -] =]
E - J! Ca_Test Berch + ;SCRM CH_LE - Dc'Piograne FPGADGNHdSesamplesiinck_ soi
u 1] sl b
a & Q8 STRUCT hd
o 5 o] Clock_Gen
| kol b
5 wig] SPEC v . .
< 3] FSM_CAR_Conkol
1 sl b Side Data RE
¥ kD O e
- !E-H_EI-.I'I_EF‘EED_EHTL_,E
B amtnlsh
# ¥y ATLam
&[] ATL vhd
£ 2 ATLIe
5 ajff) FREP2 ¢ »
| kol b
g E] Babava_1 vied Downslream NE
+ * SCRATCH_UE - D:WPrograms FF UG DINHD wosmples s _sou
L ¥
¢ ¥ | 5 Deson Compier [ 1 Leorwsdapectum | [} Modetin |
Heady
Figura 3

Se propune realizarea unui design pe baza surselor VHDL deja existente. FPGAdv poate
recupera coduri VHDL sau Verilog si le poate converti coduri VHDL proprii si diagrame grafice HDS.

1. Pentru aceasta, mai intai se deschide un nou browser pe calea: File > New Design Browser
si se inchide cel anterior.

2. Se selecteaza HDL > Full HDL Import si se bifeaza Specify HDL files si VHDL si se
trece pasul urmator apasand butonul Next.

i+ Specify HOL files f* YHDL
i~ Read from a filelizt  Yerilog

3.1n dialogul urmator, se alege cu Browse calea catre sursele VHDL.

Directary IE:HLucruHFF‘G.ﬁ.ﬁ.dv‘\Masina Browse. . |

Files of type: [\HDL Files (% vhd, *.vhdl, *.vha) -
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4. Se selecteazd Car_FSM.vhd si Car_Test.vhd utilizand butonul din stdnga al mouse-ului si tasta

. < add > | .
Ctrl. Apoi se apasd butonul 4| urmat de Next > pentru a converti sursele VHDL.

Rezultatele se pot remarca in fereastra Log Window.

Filez in Directon: Filez to Carvert:

Car FSM.vhd Add » E:sLucruhFPGASDY M azinatCar_FSM.» 25 |
Car FSH_tot.vhd E:A\LucruhFPGAAD M azinatCar_Test v

Car_Test.vhd
Car_Test_bad.vkhd

Add All >

<< Remove

<< Remove All

LB

£ | 11l) ] |

H3 Log Window : : :

|HE 2% E B EE Ve L

~|
** Reading YHOL source file E:\Lucru\FPGAADw M azinaiCar_FSk.vhd E
** Beading WHOL zource file E:\Luciu\FPGAAD M azinahCar_Test. vhd =
** Reading configuration details for degign
* HOL analysis complete N
bl
<) i 2

Log I HOL Log I
5. In dialogul urmator se verifica faptul ca sunt selectate optiunile SCRATCH_LIB si All si se

apasad butonul M.
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6. In dialogul Choose View Styles se bifeazi optiunile din figura de mai jos, apoi in dialogul
urmator — Confirm HDL Import - se bifeazd Overwrite din dialogul Options > General.

"4 HIOL Import Wizard - Choose View Styles b

Speciy e v ke 5o be used for e recovened design
 Himrarchy Descri
Reecove design himachy deschplions: o
o Gemhical Visw
i Block Disgam  ED
[~ HDL Text

Lizaf-jeeed O mzonplions
Lizafeve] desoripiions oan be necowensd a5 Shate Diagrams,
Flow Chaets snd HOL bt I no graphicsl views s= sxtracted,
the l=aideyve] desoaption vall be saved as an DL test wisw,
# Stale Diagias
B 3 Stsbe Dragnam carel be pecorized, s isw &4
™ Flews Chant o HOL Test

[ Flow Chast

[ Block Dsagram
¥ HDL Tt

< Back I-Iﬂ:-ll.‘.uﬂll—hh/Ll

. . Finizh . . . N
Se apasda apoi butonul 4| si incepe conversia, rezultatele fiind afisate in fereastra Log
Window.

Hl3 Log Window
|d B 7% B EFVaE| L
1 top level dezign unit [ Car_Test_Bench ] ]

4 HDS design unite zaved,
4 compaonients
2 block diagrams
1 ztate machine =

2 HOL views v
< Il | B3

Lag HOL Log
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3. Examinarea proiectului

Se pot vizualiza toate componentele designului selectand SCRATCH_LIB si alegand optiunea
Expand All cu ajutorul unui click pe butonul din dreapta al mouse-ului.

1. Se examineazd modulul de test facind dublu click pe il CAR_Test_Bench. Se pot utiliza
butoanele pLRROP pentru ZOOM. De asemenea se poate vizualiza continutul blocurilor prin

dublu click pe acestea. Dupa examinare inchideti toate ferestrele cu exceptia Log Window si Design
Browser pentru a trece la pasul urmator.

HDL usng HOLZ Graphica TR Tashaala gy
o - 10037205 Oz 12001

Cagated By bgatar Graphics’ HOL Designi Seres Import
M = ENL UG F P ofutaibtagin i D ar_Testvhd

SCRATCH_LIB SCRATCH_LIB
FSM_CAR_Conrol - FSM_CAR_SPEED_CHTL 2

i . . . . c.'

Fechage List  Declarwlions

2. Cu un dublu click pe ;.FSM_ CAR SPEED CNTL 2 se poate deschide diagrama de stari
pe care a generat-o automat programul. Aceasta se poate analiza utilizand butoanele de ZOOM.
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4. Simularea

FPGAdv utilizeaza ca instrument pentru simulare ModelSim-ul. In momentul lansirii
ModelSim-ului din FPGAdv, programul genereaza niste surse VHDL pe care le simuleaza, pe baza
celor originale introduse de utilizator (Car_FSM.vhd si Car_Test.vhd). Nu intotdeauna insd programul
reuseste sa se descurce si s interpreteze in mod corect ceea ce am vrut noi sa spunem, asa incat, uneori,
dupa cum se va vedea in continuare, mai trebuie ajutat.

1. Se selecteazi CAR_Test Bench din Design Browser si apoi se apasd butonul “ . In acest
moment fereastra Log Window devine foarte importantd, deoarece putem urmari in aceasta modul in
care unititile design-ului sunt generate, incarcate si compilate.

in cazul de fatd remarcam cd apar erori si anume programul nu recunoaste un anumit tip de date
pe care el insusi incercase anterior sd-1 creeze. Atunci se citeste in Log Window in linia anterioara liniei
ce  indica  eroarea  (care  spre exemplu ar putea fi -  Reading  file
... \FPGAdv50\ Hds | examples \ hds_scratch\scratch_lib\hdI\fsm_car _speed _cntl 2 rtl.vhd"),
calea spre sursa generatd In care apar erori si se deschide acea sursa cu un editor de texte (spre exemplu

NotePad-ul) si se comenteaza liniile urmatoare:
-- Architecture Declarations

--TYPE STATE_TYPE | S (

-- Fast ,

-- Medi um

- - Sl ow,

-- St op

=)

deoarece acest tip este deja definit iar prin incercarea automata de redefinire apar erori.
Dupa aceasta se salveaza fisierul respectiv (fsm_car_speed_cntl_2_rtl.vhd) prin suprascriere.

2. In acest moment se reia pasul 1 si se remarca urmarind Log Window ci nu mai apar erori. Se
accepta optiunile implicite din fereastra de pornire a ModelSim-ului si se trece mai departe apasandu-se
| K.

butonul . Cum generarea si compilarea s-au incheiat cu succes, simulatorul ModelSim este
invocat si designul compilat este incarcat.

3. Se lasa deschis ModelSim-ul si se revine in Design Browser, de unde se deschide diagrama
bloc de test prin dublu click pe 238 CAR_Test_Bench. Se utilizeaza butoanele de ZOOM pani cand
diagrama devine vizibila, iar fereastra sa nu ocupa mai mult de un sfert de ecran. Se deplaseaza fereastra
astfel incat sa ocupe cu aproximatie sfertul din dreapta sus.

4. In fereastra cu diagrama block, ficand uz de tasta Cerl si butonul din stAnga al mouse-ului (click pe
firele dintre blocuri), se selecteazd semnalele: Clock, Keys, Brake, Accelerate si Speed. Pentru a se

monitoriza valorile acestor semnale, cu ele selectate, se apasa butonul 8 din bara meniuri din josul
ferestrei. Apoi, pentru a se introduce automat aceste semnale in fereastra cu forme de undi (wave) a

ModelSim-ului, se apasa butonul i din aceeasi bard de meniuri.

Se are grija ca in fereastra wave pentru semnalul Speed si fie selectata optiunea Binary din
meniul Radix ce se deschide printr-un click dreapta pe semnal.

5. Redeschideti  diagrama de stari a FSM  printr-un  dublu  click  pe

;DFSM_CAR_SPEED_ CNTL 2, in Design Browser. Apoi activati animarea diagramei de stari,

apasand butonul din fereastra cu diagrama de stari. Mutati aceasta fereastra in coltul din stanga jos
a ecranului astfel incat pe ecran sa rimana vizibile urmatoarele ferestre: fereastra de control ModelSim,
fereastra cu formele de unda — Wave -, fereastra cu diagrama bloc a test bench-ului si fereastra cu
diagrama de stari.
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®

Utilizati butoanele de ZOOM in fereastra cu diagramele de stiri pentru vizionarea optima a
tuturor celor patru stdri. La pornirea simuldrii, in trei dintre ferestre se vor putea urmari
modificarile pe care le suferd semnalele monitorizate in timpul simuldrii. Pe diagrama de stari,
starea curentd va fi colorata cu rosu, iar starea anterioara va fi galbena.

6. In acest moment puteti incepe simularea: in fereastra cu diagrama de stari faceti succesiv click

pe butonul g din bara de meniuri din josul ferestrei, echivalentul cu rularea cu cate 100ns de fiecare
data. Observati modificarile ce se petrec asupra semnalelor in cele trei ferestre (fereastra cu formele de
unda — Wave -, fereastra cu diagrama bloc a test bench-ului si fereastra cu diagrama de stdri). Cand
ajungeti la 3000ns, opriti-va si trageti niste concluzii referitoare la rdspunsurile date la intrebarile 1-4 de
la inceputul studiului FPGA Advantage.

In primul rand, remarcati ci desi urmarind sursa VHDL, la prima vedere am fi tentati si
credem cd semnalul Speed se modifica pe frontul cazitor al Clock-ului, in realitate, numai
Speed_s se modifica pe frontul cizator, insa Speed nu apuca si se actualizeze cu proaspita
valoare a lui Speed._s, ci se actualizeaza cu valoarea veche a lui Speed._s, adica cea pe care o avea
inainte de intrarea in proces (mai exact cu cea de la evenimentul anterior ce a determinat intrarea
in proces, adica de pe frontul crescator anterior al Clock-ului).

Pentru a raspunde la intrebarea a doua, exista doua cai: Speed sa fie declarat ca variabila
locala a procesului, ceea ce nu convine, fiindca Speed este necesar in afara procesului, sau cea de-
a doua solutie, care este de altfel si viabila, constd in scoaterea in afara procesului a atribuirii
Speed <= Speed_s;. De altfel, la sfarsitul laboratorului se poate incerca simularea (doar cu
ModelSim-ul) a acestei variante, care este descrisa in listingul de mai jos. De mentionat ca
varianta de mai jos contine si testarea maginii in aceeasi arhitectura

Referitor la sincronicitate, este clar ca semnalul Keys, ce joacd rolul de reset, este prioritar
fata de Clock, deci structura este asincrona.

Cat priveste succesiunea starilor FSM, aceasta este acum evidentd datoritd simularii:
Necunoscuta, Stop, Stop, Slow, Medium, Slow, Stop, Stop, Slow, Medium, Fast, Fast, Medium,
Slow, Stop, Stop, Stop, ...

7. Se vor inchide toate ferestrele legate de FPGA Advantage si ModelSim, cu exceptia Design

Browser si Log Window, pentru a putea trece la etapa urmatoare: sinteza.
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-- Car_FSM Tot . vhd

-- Atentie la nmetoda de codare a starilor fara package cu tip de date

-- Stop =11

-- Slow =10

-- Medium = 01

-- Fast = 00

-- bs: Nu se mai poate face sinteza cu continutul acestui
library | EEE;

use | EEE. STD Logi c_1164.all, |EEE. Nuneric_STD. all;

entity Clock_Gen is
port (dock: out std_logic);
end C ock_Gen;

architecture SPEC of C ock_Gen is
constant clk_prd: tinme := 200 ns;
si gnal int_clk: std_logic :="0";

begin
int_clk <= not int_clk after clk_prd/?2;
Clock <= int_clk;

end SPEC,

library | EEE;
use | EEE. STD Logi c_1164.all, |EEE. Nuneric_STD. all;

entity FSM CAR SPEED CNTL_2 Tot is
port (Speed:out unsigned (1 downto 0));
end; -- entity FSM CAR SPEED CNTL_2_ Tot;

architecture RTL of FSM CAR SPEED CNTL_2 Tot is

constant Stop: unsi gned(1 downto 0):="11";
constant Sl ow unsi gned(1 downto 0):="10";
constant Medi um unsi gned(1 downto 0):="01";
constant Fast: unsi gned(1 downto 0):="00";
si gnal Next Speed: unsigned(1 downto 0);

si gnal Speed_s: unsi gned(1 downto 0);

signal O ock, Keys, Brake, Accelerate: std_logic;
constant clk_prd: tinme := 200 ns;

conponent C ock_Gen
port (Cd ock: out std_logic);
end conponent;

begin

Sursa: C ock_Gen
port map (d ock => d ock);

process
begin

fisier

Keys <= "'0' after clk_prd/2,'1" after 2*clk_prd, '0'" after
Brake <= '0' after clk_prd/2, '1' after 4*clk_prd, 'O

after 11*clk_prd, '0" after 14*clk_prd;

Accelerate <= '0' after clk_prd/2, "1' after

"1' after 7*clk_prd, '0' after 10*cl k_prd;
wait for 15*cl k_prd;

end process;
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FSM2_COMB: process(Keys, Brake, Accelerate, Speed_s, Next Speed)
begin
--"Speed_s" este un semal intern care porteaza semal ul "Speed",
--astfel incat "Speed" sa ramana de tip "out”
case Speed_s is
when Stop =>
if (Accelerate='1") then
Next Speed <= Sl ow,
el se
Next Speed <= St op;
end if;
when Sl ow =>
if (Brake='1") then
Next Speed <= St op;
el sif (Accelerate="1") then
Next Speed <= Medi um
el se
Next Speed <= Sl ow,
end if;
when Medi um =>
if (Brake="1") then
Next Speed <= Sl ow,
elsif (Accelerate="1") then
Next Speed <= Fast;
el se
Next Speed <= Medi um
end if;
when Fast =>
if (Brake="1") then
Next Speed <= Medi um
el se
Next Speed <= Fast;
end if;
when ot hers =>
Next Speed <= St op;
end case;
end process FSM2_COWVB;

--Atentie |la scoaterea atribuirii in afara procesul ui:
FSM2_SEQ process (O ock, Keys)
begin

if (Keys='0') then
Speed_s <= Stop;
el sif falling_edge(d ock) then
Speed_s <= Next Speed;
end if;
end process FSM2_SEQ
Speed <= Speed_s;

end; -- architecture RTL;
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5. Sinteza

FPGA Advantage utilizeaza pentru sintezd LeonardoSpectrum. Cu ajutorul acestuia se
Incearcd implementarea fizicd a circuitului descris la nivel RTL (in VHDL in cazul nostru), utilizand
componente (porti, bistabile, latch-uri, etc.) predefinite, specifice unei tehnologii. In acest caz se
utilizeaza tehnologia FPGA, cu libraria de componente XC4000E de la firma Xilinx. S-ar putea folosi
spre exemplu si tehnologia ASIC, cu libriria de componente CX2001_nom a firmei Chip Express.

L
1. Se selecteaza FSM_CAR SPEED CNTL 2 si se apasi butonul 5 lansandu-se astfel
LeonardoSpectrum pentru FSM_CAR SPEED CNTL 2. In continuare se aleg parametrii din
figura de mai jos si se lasd programul si-si urmeze cursul automat.

H LeonardoSpectrum Invoke Settings @
General | Fun Scripts  Quick Setup |

[v Run Quick Setup

Techhnologies:

Device:

+- Lypress - 4013ePO160 -
+- Lattice | J
9 Lucent Speed Grade:
+- Minc |'3 ﬂ
+- QuickLogic \wire T able:
= Hilir :

SCA000E 401323 [

#C4000E: Clock Frequency:

#C40000 = |2|:| bz

O ptirnization

[+ Optimize for:
" Delap ™ Area © Auto

[ Prezerve Hierarchy

Iv |nzert |0 Pads
| Extended Optirmization E ffart
Iv Generate Summary Repoart

OukpLt
[v Deszign Netlst: |D JPrograme/FPGAdYE0/Hdz eramples/hds_zcratchy

Format: & EDIF WM

Place and Route
[v Fun Place & Route Format: & WHDL 7 Verilog

Tirmnirg Metlist Path ; |D:.-"F'ru:ugrame.-"FF'G.-'i'-.dx-'EEI.-"Hds.-"e:-:amples.-"hds_s-:rat-:h;"

Defaults | | (] | Cancel

2. Urmatorul pas este vizualizarea schemei rezultate In urma sintezei din sursele VHDL, prin

apasarea butonului ®4 | rezultatul fiind prezentat in figura de mai jos.
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reg_Speed_=(1)

]

modgen_mux_5

reg_Speed s(

=]

Clack [
Weys [
[t
n out
[
53 in[o 27
Brake D—l n D()'M in[1] i
Arcelerate [ .
injo 21

- out
in[1

modgen_mux_4

Speed1:0]

3. Pentru vizualizarea optima se pot folosi optiunile de ZOOM din meniul Schematic Viewer.
De asemenea, pentru vizualizarea codului VHDL ce a dus la generarea unei componente, se poate
utiliza comanda Trace to HDL Source din meniul ce se deschide printr-un click dreapta al mouse-ului
pe una din componente.

incercagi sa deduceti care portiune din codul VHDL sursa a determinat aparitia prin sinteza a
fiecarei componente in parte.

Trebuie mentionat cd schema obtinuta prin sinteza are un corespondent in cod HDL, precum si
in format SDF (Standard Delay Format) sau in alt format, care la simularea cu acelasi test bench ca st
sursele originale VHDL trebuie sa dea aceleasi rezultate. Fisierele cu acest cod corespondent se poate
obtine ca in figura de mai jos, folosind butonul Write. Folosind fisierele SDF, dupa ce ne-am asigurat ca
ele contin ceea ce am dorit noi sa facem cand am scris codul RTL original, se parcurg si restul de etape
pana la realizarea si verificarea layout-ului pentru chip — componenta fizica.

Filename:

Format:

O Auto & WHDL & “erilog
i =DBE i Preference

i EDIF " SDF

v *wfihite vendor constraints file
¥ Pre-Process netlist
I “wiite only the top level of hierarchy to file
I “wirite modules

D ovanto:

= Technology Cells
= Primitives

|SM_CAR_SPEED_CMTL_O sdf _ﬂ

=B

WA Tite

i MCF

Help
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6. Lucru individual

In cele ce urmeazi se prezinti o schemd bloc si implementarea sa VHDL. Se cere:
1. Implementarea in VHDL a unui test bench si simularea cu ModelSim.
2. Deschiderea cu FPGA Advantage a arhitecturii PREPZ si vizualizarea acesteia prin dublu click pe

SHpPREP2 Observatie: la deschiderea FPGAdy si importarea unui design, se vor utiliza optiunile din
figura de mai jos. Mentionam ca in acest caz programul nu mai poate genera o diagrama de stdri, dar
poate genera o schemd logica.

3. Sinteza cu ajutorul LeonardoSpectrum a arhitecturii PREPZ2 si studiul schemei obtinute dupa
sinteza, prin compararea cu cea bloc initiald, prezentata in cele ce urmeaza.

H[3 HDL Import Wizard - Choose View Styles

Specify the view styles to be uzed for the recovered design;

— Hierarchy Descriptions
Recover design hierarchy descriptions as:

[v Graphical Wiew
+ Black Diagram " |BD
[T HOL Text

— Leaf-level Descriptions

Leaf-level dezcriptions can be recovered as State Diagramz,
Flow Charts and HDL test. If no graphical views are estracted,
the [eaf-level descrption will be saved as an HOL text wiew,

[+ State Diagram
If a State Diagram cannot be recognized, zave view az
£~ Flaw Chart s HOL Text
[+ Flaw Chart
[+ Block Diagram
[w HOL Text

< Back, Mext = Cancel Help |
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D2 D1 Sel

MUX

Ldhi_ | hi
Regiistru

Ldlo_ |

lo

Reset

lo

Counter

Clock

Comp

-- Individ. vhd
-- sintetizabil EQ

library | EEE;
use | EEE. STD Logic_1164. al | ;
use | EEE. STD Logi c_Unsi gned. al | ;

entity PREP2 is
port (CLK, Reset, Sel, Ldlo, Ldhi: BIT;
D1, D2: STD LOGA C VECTOR(7 downto 0);
DQ out STD LOG C_VECTOR(7 downto 0) );
end;

architecture Behave_1 of PREP2 is
signal EQ BIT;
signal y,lo,hi,Qi: STD LOG C_VECTOR(7 downto 0);

begi n
outputDriver: DQ <= Q.i;
mux: with Sel select y <= hi when '0', Dl when '1';
conparator: EQ<="'1" when Qi =10 else '0';

regi stru: process(Reset, CLK)
begi n
if Reset = '1'" then
hi <= "00000000";
|l o <= "00000000";
elsif CLK = '1" and CLK EVENT then
if Ldhi ="'1" then
hi <= D2;
end if;
if Ldlo = '1" then
lo <= d2;
end if;
end if;
end process registru;

counter: process(Reset, CLK)
begi n
if Reset = '1' then
Qi <= "00000000";
elsif CLK = '1'" and CLK EVENT then
if EQ="1 then
Qi <=vy;
else --if EQ="0" then
Qi <= Qi + "00000001";
end if;
end if;
end process counter;

end;
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T HER="0'then
| @j==0j+"00000001"
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